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Fabbricante / Výrobce / Fabricant / Fabricante / Hersteller / Fabricante 
 

TECNO-GAZ S.p.A. 
Strada Cavalli, 4 

43038 Sala Baganza (PR) 
 

ITÁLIE 
 

IT 
Nel presente manuale istruzioni il termine “autoclave” è equivalente a 
piccole sterilizzatrici a vapore (EN13060). 

CZ 
Termín „autokláv“ používaný v tomto návodu znamená malý parní 
sterilizátor (EN13060). 

FR 
Dans le présent manuel instructions le terme “autoclave” est équivalent 
à petit stérilisateur à vapeur (EN13060). 

DE 
In dieser Gebrauchsanweisung ist das Wort “Autoklav” wie Kleiner 
Dampfsterilisator gemeint (EN13060). 

ES 
En este manual de instrucciones, el término “autoclave” es equivalente 
à pequeño esterilsador de vapor (EN13060). 

PT 
Neste manual de instruções, o termo “autoclave” é equivalente a 
esterilizadores a vapor pequenos (EN13060). 

 

 

Questo apparecchio assolve ai criteri di conformità CE in quanto conforme alla direttiva 93/42/CEE. La 
dichiarazione di conformità originale è fornita in allegato al manuale. 

 
 

Tento přístroj odpovídá směrnici 93/42/CE. Původní prohlášení o shodě je přílohou návodu k použití. 
 

Cet appareil est conforme aux prescriptions CE puisque il respecte la instruction 93/42/CEE. La 
déclaration de conformité est jointe au manuel d’usage. 

 

 

Das Gerät stimmt mit CE Norm. Es beachtet die Norm 93/42/EWG. Die Original Konformitätserklärung 
ist der Gebrauchsanleitung beigefügt. 

 
 

El dispositvo es conforme con los criterios CE ya que respecta la norma 93/42/CE. 
La declaración original es incluída en el manual de uso. 

 
 

Este aparelho satisfaz os critérios de conformidade CE, pois é conforme com a diretiva 93/42/CEE. A 
declaração de conformidade original é fornecida anexada ao manual. 
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VÝROBCE SI VYHRAZUJE PRÁVO PROVÁDĚT TECHNICKÉ ZMĚNY VEDOUCÍ K VYLEPŠENÍ 
BEZ PŘEDCHOZÍHO UPOZORNĚNÍ. TENTO NÁVOD JE VLASTNICTVÍM SPOLEČNOTI 
TECNO-GAZ S.P.A. A NEMŮŽE BÝT KOPÍROVÁN, REPRODUKOVÁN ANI PŘENÁŠEN TŘETÍM 
STRANÁM BEZ PÍSEMNÉHO SOUHLASU TECNO-GAZ S.P.A. 
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Vážení zákazníci, 
 

děkujeme, že jste si vybrali náš autokláv, velmi si vážíme Vaší věrnosti a uděláme maximum 
pro to, aby naše služby splnily veškerá očekávání. 

 
Před použitím tohoto autoklávu vyzýváme k pozornému přečtení návodu k použití, potom jej 
prosím uložte na místě dobře přístupném všem pracovníkům, kteří se zabývají STERILIZACÍ. 

 
Při sterilizaci je zapotřebí používat specifické pracovní metody a dodržovat přesné provozní 
protokoly: 

 
DIZINFEKCE povinná fáze, která zajistí bezpečnost obsluhy, provádí se ponořením do 
chemických roztoků nebo termickou dezinfekcí; 

 
ČIŠTĚNÍ nejdůležitější fáze, která zajistí odstranění všech chemických i biologických reziduí. 
Nejvhodnějšími nástroji jsou ultrazvukové čističky; 

 
SUŠENÍ zásadní fáze, která zabraňuje korozi nástrojů a narušení vlivem 
STERILIZAČNÍCH cyklů; 

 
ULOŽENÍ DO OBALU důležitá fáze pro zachování sterility v průběhu času; 

 

STERILIZACE konečný krok parní STERILIZACE. 
 
 

 

Autoklávovaní je klíčovým krokem této metody. 
 
 
 

 

Připomínáme, že vynechání kterékoli fáze může zneplatnit konečný výsledek procesu 
STERILIZACE. 

 
O provedení instalace, údržby a případné pomoci požádejte výhradně autorizovaný technický 
personál. Používejte a vyžadujte výhradně originální náhradní díly. 

01 ÚVOD 
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Autokláv je třeba používat pouze ke sterilizaci nástrojů a materiálů, které 
jsou kompatibilní se systémem parní sterilizace. 
Vždy si ověřte, zda náplň, kterou se chystáte sterilizovat, snáší teploty 
stanovené pro zvolený cyklus. 

 

 
 

Autokláv dokáže sterilizovat tři druhy materiálů daných normou EN13060, zejména: 
 
 

 
ONYX-B 5.0 ONYX-B 8.0 

 
KOVOVÉ A KOMPAKTNÍ MATERIÁLY 

Nástroje bez dutin a výčnělků, kam by mohla 
vnikat pára 

 

 
max kg. 5 

 

 
max kg. 8 

PORÉZNÍ PŘEDMĚTY 

Elementární nebo kompozitní materiály, které 
mohou absorbovat tekutiny (tkaniny, oděvy, 
chirurgická gáza, krytí apod.) 

 

 
max kg. 1,5 

 

 
max kg. 2 

 
DUTÉ PŘEDMĚTY 

Materiály nebo nástroje s dutinami, překážkami 
apod. Ty se dále dělí na dva druhy, 
klasifikované podle délky a průměru dutiny. 

 
Přibližně: 

 
TYP B: kanyly, trubice nebo nástroje s dlouhými 
kanály. 
 
TYP A: turbíny, rukojeti a nástroje se slepými 
nebo malými otvory 

 
 
 
 
 
 

max kg. 5 

 
 
 
 
 
 

max kg. 8 

 

Náplň (kg) se mění podle druhu cyklu, který se spustí. Viz obr.B. 

 
*Pouze pro evropské země 

 
 
 

02 POUŽÍVÁNÍ A CÍLOVÉ POUŽITÍ AUTOKLÁVU 
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  3.1 Bezpečnostní označení  

 
 
 
 

RIZIKOVÉ 

NAPĚTÍ 

 
 
 

VYSOKÁ TEPLOTA 

 

ODPOJTE 

 

OD SÍTĚ 

PŘED 

SEJMUTÍM 

PŘIPOJENÍ 

ZEMNĚNÍ 

VÍKA  

 
  3.2 Bezpečnostní zařízení  

 
Instalována jsou následující bezpečnostní zařízení: 

 
1. Bezpečnostní ventil nastavený na 2,4 bar 0/+10 % 

2. Elektromagnetický zámek, který brání otevření dvířek, pokud je cyklus v běhu 

3. Termostaty chránící proti přehřátí 
 

  3.3 Bezpečnostní upozornění  

 
1. Výrobce je odpovědný za produkt dodávaný na trh v souladu s platnými nařízeními. 

Výrobce se zříká odpovědnosti, pokud provoz přístroje nebo jeho části obsluhuje 
nezkušený personál nebo byly použity neoriginální náhradní díly. 

2. V místnosti, kam je autokláv instalován, nesmí být rizikové zdroje výbuchu či požáru. 
3. Autokláv musí být instalován do dobře větrané místnosti. 

 

  3.4 Likvidace  
 

. 

Viz dodatek 

Kódy 0Z00H0004 

BEZPEČNOST 03 
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ONYX 5.0 ONYX 8.0 

M
E

C
H

A
N

IC
K

É
 Ú

D
A

J
E

 

Provozní teplota +5°C  +40°C

Maximální nadmořská výška 2.000 m 

Max. relativní vlhkost při 30 °C 80 % 

Max. relativní vlhkost při 40°C 50 % 

Rozměry 

(d x v x š) mm 474 x 497 x 650 474 x 497 x 795 

Rozměry s otevřenými dvířky 495 mm 

Hmotnost (prázdné nádoby) 60 kg. 66 kg. 

Hmotnost (plné nádrže + plná komora) 70 kg. 76 kg. 

Hmotnost podpůrné zóny 2058 N/m2 

Možná hladina zvuku < 70 db A 

E
L

E
K

T
R

IC
K
É

 Ú
D

A
J

E
 

Napájecí napětí 230 V a.c. +/-10 % jednofázový 

Napájení MAX 1,5 kW 2,2 kW 

Frekvence 50 / 60 Hz 

Napájecí kabel 2 + 1 x 1 mm2 

Pojistky 5x20 10A 6.3x35 F12A 

Tepelný přenos 3.6 E6 J / hour 

K
O

M
O

R
A

 

MAX. provozní tlak 2.4 bar (relativní) 
MAX. prázdný - 0.9 bar (relativní)
MAX. teplota 138 °C 

Materiál Inox AISI 304 

Rozměry (mm) Ø 245 x 320 Ø 245 x 500

N
Á

D
R

Ž
 

N
A

 

Č
IS

T
O

U
 

V
O

D
U

 

Objem 4,5 l 

Užitné cykly 4 2 

Materiál polyethylén  

N
Á

D
R

Ž
 

N
A

 

P
O

U
Ž

IT
O
U

 V
O

D
U

 

Objem 4,5 l 

Užitné cykly 4 2 

Materiál polyethylén 

MAX. teplota použité vody 50 °C 

B
A

C
T

E
R

IÁ
L

N
Í

F
IL

T
R

 Průměr 
56 mm 

Filtrační kapacita 0.3 m 

04 TECHNICKÉ ÚDAJE 



ČEŠTINA 

7 

S
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M

 V
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S
T

U
P

Ů
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 I
N

D
IK

Á
T

O
R

Ů
 (

O
b

r.
 A

) 

00 Mezikus 

01 Zdířka pro připojení osmotického systému 

02 RS232 sériový port 

03 Přihrádka s pojistkami 

04 Kohoutek pro vyprázdnění nádrže na čistou vodu - Kohoutek pro naplnění 
pomocí osmózy 

05 Přepad nádrže na použitou vodu 

06 Armatura pro vyprázdnění nádrže na použitou vodu (zadní) 

07 Kohoutek na vyprázdnění nádrže na použitou vodu 

08 Displej 

09 Bakteriální filtr 

10 Slot SD karty 

11 Síťový vypínač 

12 Armatura pro vyprázdnění nádrže na použitou vodu (přední) 

13 Armatura pro manuální napuštění čisté vody 

14 121°C cyklus 

15 134°C cyklus 

16 134°C rychlý cyklus 

17 134°C bleskový cyklus 

18 134°C bezpečnostní cyklus 

19 134°C předběžný cyklus 

20 134°C předběžný rychlý cyklus 

21 Helix / Bowie&Dick test 

22 Vakuový test 

23 MAX. hladina nádrže na použitou vodu 

24 MAX. hladina nádrže na čistou vodu 

25 MIN. hladina nádrže na čistou vodu 

B-M1 Multifunkční tlačítko 1 

B-M2 Multifunkční tlačítko 2 

B-M3 Multifunkční tlačítko 3 

ČERPA
DLO Tlačítko pro naplnění vody 

VODA 

VOLBA 
T Tlačítko pro zvolení cyklu 

CYKLU 

05 SEZNAM VÝSTUPŮ A INDIKÁTORŮ 
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Autokláv je dodáván ve vhodném obalu pro snadnou přepravu a manipulaci a ochranu 
obsahu. 

Obal se nesmí být vystaven nárazům, je třeba s ním manipulovat opatrně a dávat pozor, aby 
nespadl a nepřevracel se. 

Pro samostatnou manipulaci není k dispozici žádná rukojeť, proto zabalený autokláv 
přepravujte vždy ve dvou osobách. 

Autokláv je umístěn na dřevěné paletě a zabalen do vlnité lepenky zevnitř i zvenčí. 

Při vyjímání autoklávu z obalu nejprve odstraňte vlnitou lepenku. Autokláv zvedejte pomocí 
pásů. 

Autokláv musí vyndávat nejméně dvě osoby a pouze pomocí pásů. 

Nezvedejte autokláv za vnitřní část dvířek nebo ovládací panel, tato nesprávná 
manipulace může způsobit problémy mechanické povahy. 

POZOR: Vždy zachovejte původní obal. 

Uvnitř balení najdete následující dokumenty: 

• NÁVOD K POUŽITÍ: pozorně přečtěte a uložte na místo dostupné všem osobám, které
se zabývají sterilizací.

• CERTIFIKÁTY: je třeba uložit a zachovat.

• ZÁZNAM O INSTALACI - ZKUŠEBNÍ A ZÁRUČNÍ PODMÍNKY: musí být

vyplněna po provedení instalace přístroje podle pokynů uvedených ve formuláři.

• RYCHLÁ UŽIVATELSKÁ PŘÍRUČKA: musí být uložena poblíž přístroje.

• CERTIFIKÁT BEZPEČNOSTNÍHO VENTILU

06 VYBALENÍ 
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DRŽÁK DVOJITÉHO TÁCU 

 ONYX 5.0 ONYX 8.0 

Materiál Anodicky oxidovaný hliník 

Rozměry (d x v x š) 192 x 165 x 280 192 x 165 x 460 

 
 
 
Obrázek 

 

 

Obr.1 

Standardní obal 1 

Kód SXBA349 2ZXZA0073 

 
TÁC 

 ONYX 5.0 ONYX 8.0 

Materiál                Anodicky oxidovaný hliník 

Rozměry (d x v x š) 183 x 17 x 284 185 x 17 x 460 

 
 
 
Obrázek 

 

 

Obr.2 

Standardní obal 4 

Kód DANA049 DXLA349 
 

 KLÍČ NA VYJMUTÍ TÁCU A NASTAVENÍ DVÍŘEK  

Používá se při vyndávání tácu a nastavení dvířek (kap. 15) 
 

 
 
 
Obrázek 

 

 
Obr.3 

 

 

Obr.4 

Standardní obal 1 

Kód DANA008 

07 PŘÍSLUŠENSTVÍ 
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 HOUBA NA ČIŠTĚNÍ KOMORY A TĚSNĚNÍ DVÍŘEK  
 

Slouží k čištění sterilizační komory a těsnění dvířek (kap. 15) 
 

 

Obrázek 

 

 
Obr.5 

Standardní obal 1 

Kód CPMG004 

 
 HADICE PRO PLNĚNÍ VODOU S FILTREM A ARMATUROU  

 

Slouží k manuálnímu naplnění vodou na přední straně autoklávu (kap. 10.2) 
 

 
 
 
 

Obrázek 

 

 

Obr.6 

Standardní obal 1 

Kód DANA099 + DXBA711 + CPRG117 

 
 TRUBICE NA VYPUŠTĚNÍ VODY  

 

Slouží k vypuštění použité vody z kohoutku na přední straně autoklávu (Obr.A–poz. 13 ) - 
(kap. 10.8) 

 

 
 

Obrázek 

 

 

Obr.7 

Standardní obal 1 

Kód DANA130 
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 ČERNÝ PLASTOVÝ KOLÍK MEZIKUSU  

Mezikus připevněte na zadní panel autoklávu (Obr.A–poz. 0 ). Zajišťuje dostatečný prostor pro 
větrání, pokud autokláv postavíte blízko zdi. 

 

 
 
Obrázek 

 

 

Obr.8 

Standardní obal 1 

Kód CPAP014 

 ARMATURA PRO VYPUŠTĚNÍ ZADNÍMI KOHOUTY  

Zavřením napouštěcího kohoutu (Obr.A-poz. 2 ) vyprázdníte zásobní nádrž a utažením 
vypouštěcího kohoutu (Obr.A-poz. 4 ) vyprázdníte vypouštěcí nádrž. 

 

 
 
 

Obrázek 

 

 

Obr.9 

Standardní obal 1 

Kód CPRG096 

 HADICE PRO VYPOUŠTĚCÍ POMŮCKY  

1 - Přetoková hadice na čistou vodu 
2 - Přetoková hadice na použitou vodu 

 

1- Jeden konec hadice připojte k armatuře přetokové hadice (Obr.A-poz. 1 ) a druhý 
k regenerační nádrži na vodu. 

 

2- Připojte jeden konec hadice k armatuře (Obr. A–poz. 3 ) a druhý k nádrži na regeneraci 
použité vody. 

 

 
 
 

Obrázek 

 

 

Obr.10 

Standardní obal 3 

Kód SXBA799 
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 NAPÁJECÍ KABEL  
 

Dodaný napájecí kabel (poz. B ) zapojte samičí zástrčkou (Obr.A-poz. 5 ) do zdířky na 
zadním panelu autoklávu a potom zapojte samčí zástrčku (poz. A ) do elektrické zásuvky 
systému. 

 

 
 
 
 

Obrázek 

 

 

Obr.11 

Standardní obal 1 

Kód CECG006 

 
 PAMĚŤOVÁ KARTA  

 

Slouží k ukládání cyklů autoklávu (nejlepší kompatibilitu s přístrojem vždy zaručí použití 
originální paměťové karty). 
VAROVÁNÍ: Karta obsahuje software ke čtení záznamu cyklu - Kartu instalujte do 
počítače před uvedením autoklávu do provozu (viz kap.12) 

 

 

Obrázek 

 

 
Obr.12 

Standardní obal 1 

Kód CEGS001 

 

DŮLEŽITÉ 

Poptávejte a používejte vždy pouze výhradně originální příslušenství.
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 ONYX 5.0 ONYX 8.0 

A 

B 

C 

D 
Max. Otvírání 

dvířek 

650 mm 795 mm 

474 mm 

497 mm 

495 mm 

E 

F 

G 

H 

I 

L 

M 

425 mm 

425 mm 

402 mm 435 mm 

min. 50 mm 

74 mm 

170 mm 275 mm 

525 mm 575 mm 

 

 

08 INSTALACE 
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1. Autokláv instalujte v prostředí vhodném k provádění sterilizace. 

2. Prostory musí být dobře osvětlené a větrané, v souladu s platnými nařízeními. 

3. Autokláv neinstalujte do blízkosti zdrojů tepla a stříkající vody. 

4. Postavte autokláv na povrch, který snese zatížení jeho hmotností (80 kg) a má 
odpovídající plochu pro jeho rozměry. 

5. Autokláv umístěte do takové výšky, aby k němu obsluha měla dobrý přístup při provozu 
a čištění celé sterilizační komory. 

6. Otevřete dvířka autoklávu a vyndejte ze sterilizační komory příslušenství, odstraňte 
všechny obaly. 

7. Uvnitř sterilizační komory nechte pouze držák s tácy. Veškeré ostatní 
příslušenství uložte na jiné místo dostupné obsluze. 

8. Do autoklávu nic nevkládejte. 

9. Neopírejte se o dvířka. 

10. Za autoklávem ponechte prostor alespoň 5 cm, použijte mezikus (Obr.A–poz. 0  / Obr.8) 
a také po stranách, aby bylo zajištěno potřebné větrání. 

11. Dodané hadičky zapojte do konektorů v zadní části (kapitola 7). 

12. Elektrický síť, do které autokláv zapojujete musí být vždy v souladu s platnou 
legislativou a musí odpovídat specifikacím uvedeným pro přístroj. 

13. Napájecí kabel zapojte do zásuvky na zadním panelu autoklávu (Obr.A–poz. 5 ). 

14. Zapojte elektrickou zástrčku do sítě, která zajistí odpovídající napájení přístroje. 
 

POZNÁMKA: 
Nepoužívejte prodlužovací kabely, redukce ani adaptéry, mohlo by 
docházet k mikro přerušením napájení s následným generováním 
alarmu. 

 
15. Zapněte autokláv stisknutím síťového vypínače (Obr.A-poz. 10 ) a otevřete dvířka 

autoklávu. Vyčkejte několik sekund, zazní dva zvukové signály, které oznamují, 
obdržení parametrů pro automatické vyrovnání nadmořské výšky, a současně se na 
displeji zobrazí text DOOR OPEN (OTEVŘENÁ DVÍŘKA). 

 

POZNÁMKA: 
Nikdy nevolte příkazy dříve, než uslyšíte dva zvukové signály, 
autokláv by nebyl schopen přijmout programované volby. 
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Na první stránce stiskněte Setup (Nastavení) a otevře se nabídka nastavení autoklávu. 
 

JAZYK 

 

Chcete-li změnit jazyk nabídky a hlasových výzev, stiskněte 
prostřední tlačítko. 

 

 
Pomocí šipky přepínejte na další položku 

 
 
 
 
 
 

DATUM A ČAS 
 

 

 
Pomocí prostředního tlačítka otevřete nastavení data a času. 

00:00 
 

00/00/1900 
 

  
  

Když okénko bliká, přecházejte šipkou na příslušnou 
hodnotu. 

  
 

 

 
 

Dalším stisknutím prostředního tlačítka přecházíte mezi 
okénky 

0:00 

00/00/1900 

a pomocí šipky vyberte hodnotu. 

Pokračujte až do poslední navolené hodnoty. 

Posledním stisknutím prostředního tlačítka se zobrazí 

 konečná stránka výběru. 

 
 
 
 

v 

▬ 

X 

Stisknutím potvrďte zvolené hodnoty a vraťte se do nabídky nastavení. 

Stisknutím restartujete postup. 

Stisknutím zrušíte vybrané hodnoty a vrátíte se zpět do nabídky nastavení. 

09 PROGRAMOVÁNÍ DISPLEJE 
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BAKTERIÁLNÍ FILTR 

• CYCLES PERFORMED (PROVEDENÉ CYKLY): Zobrazí se cykly od poslední výměny 

filtru. 

• RESET COUNTER (RESET ČÍTAČE): Umožňuje reset čítače při výměně filtru. 

 

EXTERNÍ TISKÁRNA 
Jakmile je tiskárna instalována (volitelné příslušenství, dle pokynů uvnitř), je možné tisknout 
nalepovací štítky pro vysledovatelnost, které se nalepí na obal před zahájením sterilizace. 

00 

▲ ▼ Když okénko bliká, stisknutím šipky 
zvolte číslo štítku, který se vytiskne. 

 

 
 ▬  

Stisknutím prostředního tlačítka přejdete na další výběr. 

00 

▲ ▼ 

Když okénko bliká, stisknutím šipek vyberte 
počet měsíců do expirace. 

Posledním stisknutím prostředního tlačítka se 
zobrazí konečná stránka výběru. 

 
 
 
 

NASTAVENÍ 
OSMOTICKÉHO SYSTÉMU 

• USE OSMOSI’S SYSTEM (POUŽITÍ OSMOT. 
SYSTÉMU): Zapnutí/vypnutí  tlačítkem 

▬ se do systému zapne 
přívod 

z osmotického zařízení (volitelné). Když je systém aktivován, nábojová pumpa se odpojí. 

• CYCLES SINCE CHG (CYKLŮ OD VÝMĚNY): Zobrazí se cykly od poslední výměny 

filtrů. 

• RESET OSMOSI COUNTER (RESET OSMOT. ČÍTAČE): Umožňuje reset čítače při 
výměně filtrů. 
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SERVISNÍ REŽIM 
Přístup do servisní nabídky (po zadání hesla). Tento režim je vyhrazen pouze pro 
autorizovaný personál. Výrobce nenese žádnou odpovědnost za žádné poškození nebo 
úrazy způsobené neautorizovanou osobou. 

 

 

SPRÁVCE ÚČTŮ 
• SHOW USERS (ZOBRAZIT UŽIVATELE): Umožní zobrazit již registrované uživatele. 

• NEW USERS (NOVÍ UŽIVATELÉ): Pro registraci nového uživatele 

• DELETE (SMAZAT): Pro smazání již registrovaného uživatele 

• LOAD CHECK (KONTROLA NÁPLNĚ): zap/vyp (kap. 10.6). 

 

NEW USERS (NOVÍ UŽIVATELÉ): 
 

                Stisknutím prostředního tlačítka zadáte nového uživatele. 

 
 
 

  

ENTER NAME (ZADAT JMÉNO): Když políčko bliká, 

pomocí šipky navolte znaky pro zadání jména uživatele, 

každé políčko potvrdíte tlačítkem   ▬  . 

ENTER PASSWORD (ZADAT HESLO): zvolte příslušné 
heslo stejným způsobem jako při zadání jména. 
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10.1 Zapnutí autoklávu a seřízení s barometrickým tlakem 

 

 

 
 

Po instalaci autoklávu můžete přistoupit k přípravě k použití. 
 

 

Stiskněte síťový vypínač (Obr.A–poz. 10 ). Zobrazí se logo, autokláv zkontroluje paměť a 
připojení. Po dokončení testů se autokláv přepne do provozního nastavení. 

 

 

Otevřete dvířka a počkejte několik sekund, až zvukový signál oznámí, že bylo dosaženo 
automatického vyrovnání hodnot barometrického tlaku a současně displej zobrazí zprávu 
DOOR OPEN (OTEVŘENÁ DVÍŘKA). 

 

AUTOKLÁV JE PŘIPRAVEN K POUŽÍVÁNÍ 

 

POZOR: 

Výběr kteréhokoli cyklu kromě vakuového aktivuje předehřívací 
 

S opatrností se dotýkejte povrchů ohřívače, protože jsou horké. 
 

 

 10.2 Plnění nádrže na čistou vodu  
 

Připojte dodanou hadičku (obr. 6) k přední armatuře autoklávu (obr. A-poz. 9 ). 
 

Druhý konec hadičky s filtrem vložte do nádoby s demineralizovanou nebo destilovanou 
vodou. 

 

Nyní stiskněte tlačítko PUMP WATER (ČERPAT VODU), aby se zprovoznilo čerpadlo 
napouštění vody a držte stisknuté, až se objeví odpočítávání. 

 
Čerpadlo napustí nádrž na čistou vodu uvnitř autoklávu. Není-li dosažena maximální 
hladina do 180 sekund, čerpadlo se automaticky zastaví a bude zapotřebí stisknout tlačítko 
B-PUMP. 

POKYNY K POUŽÍVÁNÍ 10 

režim autoklávu. 
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10.3 Charakteristiky používané vody 

10,4 Náplň materiálu v autoklávu 

 

Čerpadlo se automaticky zastaví po dosažení maximální hladiny. 

 

TABULKA UKAZUJE KVALITATIVNÍ ÚROVNĚ DANÉ NORMOU EN13060 
 

NORMA CEN EN13060 

Rezidua po odpaření  10 mg/l 

Oxid křemičitý  1 mg/l 

Železo  0,2 mg/l 

Kadmium  0,005 mg/l 

Olovo  0,05 mg/l 

Zbytky těžkých kovů kromě železa, kadmia, olova 
 0,1 mg/l 

Chlorid (Cl’)  2 mg/l 

Fosfát (P20s)  0,5 mg/l 

Vodivost (při 20 °C)  15 s/cm 

Hodnota pH (úroveň acidity) 5  7,5 

Vzhled Čistá, čirá, bez depozitů 

Tvrdost (a ionty alkalické zeminy)  0,02 mmol/l 

 

Naskládejte materiály ke sterilizaci na dodané tácy následujícím způsobem: 

• Materiály nepokládejte navzájem na sebe. 

• Obalené materiály uložte papírovou stranou směrem nahoru. 

• Nikdy materiály neukládejte tak, aby byly v kontaktu se sterilizační komorou nebo dvířky 

autoklávu. 

• Nůžky a zubní kleště ukládejte s otevřenými čelistmi. 
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10.5 Zahájení sterilizačního cyklu 

 

Po naložení materiálem zavřete dvířka autoklávu. Na displeji se zobrazí ikona se zprávou 
DOOR CLOSED (ZAVŘENÁ DVÍŘKA). 

 

Po provedení výše uvedených kroků zvolte nejvhodnější program STERILIZACE pro 
vloženou náplň stisknutím tlačítka SELECT CYCLE (ZVOLIT CYKLUS). 
Je-li zvolen program, spusťte cyklus stisknutím tlačítka. Dvířka se automaticky uzamknou a 
cyklus začíná. 
Během cyklu displej zobrazuje všechny parametry a údaje probíhajícího cyklu. V tomto 
stádiu displej zobrazuje: druh cyklu, stav cyklu, čas zbývající do konce cyklu (u vakuového 
testu to označuje celý cyklus, zatímco u všech ostatních cyklů to znamená sterilizační fázi 
plus sušení), počet cyklů vykonaný přístrojem a tlačítko umožňující náhled seznamu 
provozních parametrů. 

 

 

 

 

 10.6 Konec cyklu  
 

Zvukový signál oznámí obsluze ukončení STERILIZAČNÍHO cyklu a displej zobrazí ikonu a 
zprávu END CYCLE (KONEC CYKLU). 

 

Jedním ze tří multifunkčních tlačítek odemkněte dvířka stisknutím tlačítka na displeji. Je-li 
v komoře stále tlak, tlačítko nepřepne odemčení. Vyčkejte na dokončení dekomprese 
komory a opakujte akci. Když se dvířka odemknou, stiskněte kličku a otevřete je. 

 
Nyní, pokud je možnost CHARGE CONTROL SETUP → ACCOUNT MANAGEMENT (ŘÍZENÍ 
ÚČTU NASTAVENÍ KONTROLY NÁPLNĚ) “ZAPNUTA”, je vyžadováno ověření náplně 
uživatelem. Když je náplň ověřena, odsouhlaste zadáním USER (UŽIVATELE) a USER 
PASSWORD (UŽIVATELSKÉHO HESLA), poté bude vyžádáno potvrzení VALIDATED 
CHARGE (OVĚŘENÁ NÁPLŇ). Pokud náplň není ověřena, musíte zadat negativní výsledek 
pro ukončení operace NOT VALIDATED CHARGE (NEOVĚŘENÁ NÁPLŇ). 

 

 10.7  Vyložení sterilizovaného materiálu  
 

Používejte ochranné osobní pomůcky v souladu s nařízeními o bezpečnosti a hygieně 
práce. Pomocí klíče vyjměte tácy (obr.3/4), nechte nástroje odpočinout a uložte je do 
prostor, kde nehrozí kontaminace. 
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Když se rozsvítí kontrolka použité vody (obr. A-poz. 23 ), je třeba vyprázdnit nádrž použité 
vody. 

 
Pokud to není provedeno, provoz autoklávu se zablokuje. 

 

Dodanou hadičku (obr.7) vložte do nádrže s použitou vodou s umístěnou vypouštěcí 
armaturou na přední straně autoklávu (obr.A-poz. 13 ). Vložte druhý konec hadičky do 
nádoby a odšroubujte matici proti směru hod. ručiček, voda bude téci do nádoby a 
vyprázdní se nádrž. 

 
DŮLEŽITÉ: 

 

A - Hadička umístěná v odtokové nádobě nesmí být nikdy ponořená do vypouštěné vody, 
jinak může dojít k nasávání. 

 
B - Vždy vyčkejte, až bude použitá voda úplně vypuštěná. Kontrolka maximální hladiny 
použité vody se vypne, když ještě zůstává trochu vody v nádrži, proto to nepovažujte za 
potvrzení této operace. 

 
Po vyprázdnění zašroubujte matici a vyjměte hadičku. 

 

 

 10.9 Přerušení sterilizačního cyklu  
 

Sterilizační cyklus lze záměrně přerušit stisknutím tlačítka Stop alespoň na 2 sekundy. 
Autokláv vydá pípnutí a na displeji se zobrazí alarmové hlášení A001. 

 

 

 

Alarm vyrušíte současným stisknutím multifunkčního tlačítka na liště Reset 
nad jeho zrušením. 

Vyprázdnění použité vody 10.8 
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 11.1 Popis cyklů  
 

Autokláv provádí tři série cyklů: 
 

A – provozní cykly 
B – noční cykly 
C – testovací cykly 

 

 11.2  Provozní cykly  

 
Všechny provozní cykly používají frakční vakuový systém a mohou sterilizovat duté, 
porézní a kompaktní materiály, přičemž jsou rozlišeny podle priorit uživatelů a vlastností 
konkrétních sterilizovaných materiálů. Možné sterilizační teploty jsou 121°C a 134°C. 
- Cyklus 121°C Standard: používá se pro termolabilní materiály, kapacita náplně až 5 kg 
(Onyx5.0) / 8 Kg (Onyx8.0), normální délka trvání cyklu. 
- Cyklus 134°C Standard: používá se pro materiály, které nejsou termolabilní, kapacita 
náplně až 5 kg (Onyx5.0) / 8 Kg (Onyx8.0), normální délka trvání cyklu. 
- Cyklus 134°C Rychlý: má stejné použití jako cyklus 134°C Standard, ale je uzpůsoben 
pro menší náplně (5 kg (Onyx5.0) / 8 Kg (Onyx8.0), tudíž také doba trvání cyklu je kratší. 
- Cyklus 134°C Bezpečnostní: vytvořen pro případy, kdy jsou nástroje okamžitě potřebné 
k použití, má kratší dobu trvání, kapacita náplně max. 5 kg (Onyx5.0) / 8 Kg (Onyx8.0). 
Není vhodný pro náplň v obalech. 
- Cyklus 134°C Bleskový: stejně jako Bezpečnostní cyklus, slouží také pro okamžité 
potřeby nástrojů, ale má kapacitu náplně max. 5 kg (Onyx5.0) / 8 Kg (Onyx8.0). Není 
vhodný pro náplň v obalech. 
- Cyklus 134°C Předběžný: vytvořen pro Creutzfeldt-Jakobovu chorobu (syndrom šílených 
krav), kapacita náplně max. 5 kg (Onyx5.0) / 8 Kg (Onyx8.0), doba trvání cyklu je delší než 
u cyklu 134°C Standard. 
- Cyklus 134°C Předběžný rychlý: vytvořen pro potřeby provádění předběžného cyklu ale 
s menší náplní (max. 5 kg (Onyx5.0) / 8 Kg (Onyx8.0) za kratší čas. 

 

Podrobný souhrn je na Obr.B. 
 

 11.3 Noční cykly  

Autokláv je vybaven speciální funkcí spořiče. Je možné provádět všechny 
uvedené cykly bez obsluhy. Pokud se na konci cyklu neotevřou dvířka, autokláv se 
automaticky vypne a zůstane zapnutý pouze síťový vypínač (Obr.A-poz. 10 ). 
Když se dostaví obsluha, stisknutím jakéhokoli tlačítka autokláv zapne a přečte si na displeji 
údaje o provedeném cyklu. 

 

 11.4 Testovací cykly  

K dispozici jsou následující testovací cykly: 
 

- Bowie&Dick test – kap. 13.3 
- Helix test – kap. 13.4 

STERILIZAČNÍ CYKLY 11 
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- Vakuový test – kap. 13.5 
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T1,T2,T3 

předehřívací a 

vakuová fáze 

T4 

sterilizace 
 

T5 
sušení 

SCHÉMA CYKLU 

 
 

 

 11.5 Schéma cyklu  
 

 

 

TABULKA TESTŮ PODLE EN13060 

Druh 
testu 

Provozní 
cyklus 

Dynamický tlak sterilizační komory X 

Únik vzduchu X 

Prázdná komora X 

Kompaktní náplň X 

Malé porézní předměty X 

Malé porézní náplně X 

Plná porézní náplň X 

Dutá náplň B X 

Dutá náplň A X 

Více obalů X 

Sušení, kompaktní náplň X 

Sušení, porézní náplň X 
 
 

 

Společnost TECNO-GAZ je připravena provést testování 
sterilizace pro řízení vaší běžné sterilizační praxe. 
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VAROVÁNÍ: Zkontrolujte, máte-li na počítači instalován Microsoft .NET 
Framework. Pokud ne, otevřete složku Microsoft.NET na SD kartě a 
instalujte spustitelný soubor uvnitř. 

 

 

 

 

 12.1 Instalace  

 
Vložte do počítače SD paměťovou kartu. Složka 
LogViewer je umístěna na: <SD Card>:\ 

 
Otevřete SD paměťovou kartu a zkopírujte složku LogViewer do svého počítače. 

 

Otevřete složku LogViewer a spusťte program LogViewer dvojitým poklepáním na odkaz, 
viditelný pod ikonou zvětšovacího skla (Obrázek1). 

 

 

Obrázek 1: Složka LogViewer. Dvojitým poklepáním na logviewer jej spustíte. 

Pokud se program nespustí z odkazu, otevřete složku koše a spusťte program log_viewer, 
poznáte jej pod ikonou zvětšovacího skla. 

 
 
 

SOFTWARE PRO VIZUALIZACI CYKLU 12 
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12.3 Náhled souboru protokolu 

 
 

 

 
 

Výchozím jazykem při prvním spuštění programu LogViewer je angličtina. Jazyk je možno 
změnit v rozbalovací nabídce na pravé straně okna. Dostupné jazyky jsou angličtina, 
italština, němčina, francouzština a španělština. Program uloží zvolený jazyk a při příštím 
spuštění již bude uživatelské rozhraní v tomto jazyce. 

 

 

V rozbalovací nabídce zvolte File → Open  (Soubor → Otevřít) (Obrázek 2) a zobrazí se 
údaje o cyklu v příslušném souboru protokolu. Program zobrazí dialogové okno pro výběr 
souboru, který chcete otevřít. 

 

 

Obrázek 2: Okno Logviewer, položka Otevřít 

 

 
Program zobrazí protokol cyklu jako na Obrázku 3. Okno zobrazuje různé údaje: 

 

• Krok sterilizačního cyklu; 

• Datum a čas záznamu; 

• Čas do konce cyklu; 

• Teplota a tlak v komoře (hodnoty obdržené z čidla T1, T2 a P1); 

• Síťové napětí; 

• Výsledné údaje cyklu, zobrazené na posledním řádku. 

 

Název cyklu příslušející k danému protokolu je uveden v políčku uprostřed. 
 

Při čtení protokolu jsou položky voleb ve sloupci nabídky a umožňují přístup ke dvou funkcím: 
Vytvoření zprávy a vytvoření protokolu ve formátu PDF. 

Nastavení jazyka 12.2 
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Obrázek 3: režim čtení protokolu vakuového cyklu 
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 12.4 Otevření adresáře  

 

V rozbalovací nabídce File → Select (Soubor → Vybrat) (Obrázek 4) můžete procházet 
soubory protokolů v dané složce. Program zobrazí dialogové okno pro určení cesty 
k procházení. 

 
 
 

 

Obrázek 4: položka Vybrat pro procházenou složku 

Program ve vybrané složce zobrazí pouze soubory *.log s platným obsahem a jejich 
seznam, viz Obrázek 5. 
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Obrázek 5: procházení složky 

Soubory protokolů jsou zobrazeny jako seznam, který uvádí sériové číslo sterilizátoru, číslo 
cyklu, druh cyklu a výsledky. Jedním klepnutím na položku seznamu se zobrazí podrobná 
zpráva příslušného protokolu, viz Obrázek 3. 
V tomto případě je vlevo v okně se zobrazením názvu cyklu aktivní tlačítko Back (Zpět) pro 
návrat do okna procházení. 
Při procházení složky jsou položky voleb ve sloupci nabídky a umožňují přístup ke dvou 
funkcím: Vytvoření zprávy a vytvoření protokolu ve formátu PDF. 
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 12.5 Vytvoření reportu  

 
Při prohlížení protokolu výběrem z nabídky Options → Make Report (Volby → Vytvořit report) 
vytvoří program tabulku s údaji všech cyklů a zobrazí je v novém okně (Obrázek 6). 

 
 
 

 

Obrázek 6: okno reportu 

V tomto okně se dá zobrazit náhled tisku (File → Print preview) (Soubor → Náhled tisku) nebo 
tisknout (File →Print) (Soubor → Tisk). 
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 12.6 Vytvoření souboru PDF  

 
V zobrazení protokolu výběrem z nabídky Options → Make PDF (Volby → Vytvořit PDF) 
Logviewer vytvoří soubor PDF, který obsahuje údaje cyklu (Obrázek 7). 

 

 

Obrázek 7: nabídka Volby, položka Vytvořit PDF 

Soubor PDF bude vytvořen ve stejné složce, kde je umístěn soubor *.log, v podsložce 
Report, přístupné pomocí nástroje průzkumníku File Manager ve Windows. Pokud složka 
Report neexistuje, bude vytvořena. Na konci postupu program otevře cílovou složku v okně 
průzkumníku File Manager ve Windows. 

 

Obrázek 8: po vytvoření souboru PDF program uloží složku souboru Report do původní 
složky souboru protokolu 

Název vytvořeného souboru je složen takto seriovecislo-cislocyklu.pdf. 
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 12.7 Vytvoření složky PDF  

 
V režimu procházení složky je k dispozici funkce the Make folder PDF (Vytvořit složku 
PDF) v položce Options (Volby) sloupce nabídky. 

 

 

Obrázek 9: Funkce vytvoření složky PDF, zobrazená v režimu procházení složky 

 

 
Poklepáním myší se zobrazí lišta s pruhem postupu. Soubory PDF budou vytvářeny 
v procházené složce, v podsložce Report, která je přístupná nástrojem File Manager ve 
Windows. Pokud složka Report neexistuje, bude vytvořena. 

Na konci postupu program otevře cílovou složku v okně průzkumníku File Manager ve 
Windows. 

Název vytvořeného souboru je složen takto seriovecislo-cislocyklu.pdf. 
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Obrázek 10: Procházená složka s programem LogViewer a cílovou složkou vytvořených souborů. 
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Nastavení osmotického systému 

Připojení demineralizátoru 

 

 
 

 

Autokláv může také používat demineralizovanou vodu prostřednictvím externího osmotického 
demineralizačního systému (volitelné příslušenství). 
Před instalací systému musí obsluha nastavit autokláv podle následujících pokynů: 
Zapněte autokláv síťovým vypínačem (Obr. A-poz. 10 ). 

 

Když autokláv zobrazí provozní obrazovku, stiskněte tlačítko Setup (Nastavení) a zvolte 
nabídku SETUP OSMOSIS SYSTEM (NASTAVENÍ OSMOTICKÉHO SYSTÉMU). 

 
Aktivujte položku USE OSMOSI’S SYSTEM (POUŽÍT OSMOTICKÝ SYSTÉM) na ON 
(zapnuto). 

 

Zavřete nabídku a vraťte se na provozní obrazovku. 
 

POZNÁ
MKA 

Pokud při zapojeném demineralizátoru není dosažena maximální vodní 
hladina, bude provoz autoklávu zablokován. 

 
VAROVÁNÍ: 

Číslo na obrazovce řízení osmózy ukazuje, kolik STERILIZAČNÍCH cyklů proběhlo od 

výměny filtrů. 

Když je dosažen maximální počet cyklů, zpráva na obrazovce uvědomí uživatele. Mějte na 

paměti, že je třeba resetovat čítač cyklů při výměně filtru na osmotickém systému, volbou 

RESET OSMOSI COUNTER (RESET OSMOTICKÉHO SYSTÉMU) v dílčí nabídce SETUP 

OSMOSIS SYSTEM (NASTAVENÍ OSMOTICKÉHO SYSTÉMU). 

 

 
 

• Pokud je autokláv zapnutý, vypněte jej (Obr.A–poz. 10 ). 

• Uzavřete kohout přívodu demineralizátoru; 

• Instalujte demineralizátor podle pokynů v tomto návodu; 

• Oviňte samčí závit na spojovacím konektoru hadice teflonem nebo jinou pomůckou pro 
utěsnění vody; 

• Našroubujte konektor hadice na samčí závit výpusti čisté vody (Obr.A–poz. 2 ); 

• Zasuňte hadici demineralizátoru do spojovacího konektrou hadice a našroubujte ji 
k autoklávu; 

• Zapojte spojovací konektor plnění demineralizátoru do portu (Obr.A–poz. 7 ) na zadním 
panelu autoklávu; 

• Otevřete ventil přívodu demineralizátoru; 

• Zkontrolujte, zda nikde neuniká voda; 

13 INSTALACE OSMOTICKÉHO SYSTÉMU 
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• Zapněte autokláv; 

• Proveďte jeden či více sterilizačních cyklů, abyste mohli zkontrolovat správné připojení a 
hlavně že nikde nedochází k úniku. 

 
 
 
 

 

 

 
 

POZNÁMKA  

POZNÁMKA 

Každý den po skončení provozu vždy zavřete kohout přívodu 
demineralizátoru. 

Demineralizátory připojujte jen k vhodným autoklávům. 

Pokyny ohledně připojení demineralizátorů k autoklávům uvádí také návod 
k použití demineralizátoru. 

První plnění může trvat delší dobu. Poté se autokláv bude plnit automaticky 
během cyklu. 
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Čištění komory Každých 20 cyklů nebo jednou 
týdně 

Čištění filtru komory Každých 20 cyklů nebo jednou 
týdně 

Čištění tácu a držáku Každých 20 cyklů nebo jednou 
týdně 

Výměna bakteriologického filtru Každých 200 cyklů nebo když ztmavne jeho barva 

Čištění těsnění dvířek Každých 20 cyklů nebo jednou 
týdně 

 

 

Správná údržba autoklávu zaručí jeho správné fungování a zajistí bezpečnou úsporu času 
a nákladů na servis a asistenci. Následující operace jsou povinni provádět uživatelé. 

 

 

Pravidelně čistěte komoru, odstraňte případné zbytky či nečistoty, aby se nedostaly do 
vypouštěcího okruhu a nezpůsobily ucpání. Pro správné čištění používejte pouze 
deminerlizovanou vodu a dodanou abrazivní houbičku (neabrazivní strana – Obr. 5). 

 

Prevence popálení: provádět s úplně studenou komorou – Nikdy nepoužívejte 
rozpouštědla, čisticí prostředky, chemické roztoky, prostředky na odstraňování vodního 
kamene ani jiné podobné produkty. 

 

 

Vytáhněte filtr (náhr. díl DXBA091), dejte pozor, aby se nezničil, umyjte demineralizovanou 
vodou a osušte hadříkem. Potom vyměňte uložení, které musí vyčnívat cca 15 mm. 

 

   

 

Čistěte dodanou houbičkou (neabrazivní stranou) a demineralizovanou vodou. 
 

 

Vyměňte bakteriologický filtr (Obr.A–poz. 9 ), otočením proti směru hodinových ručiček 
odšroubujte a po směru hod. ručiček zašroubujte. Používejte pouze originální filtry (náhr. díl 
DAVA101). Mějte na paměti, že je třeba resetovat čítač cyklů při výměně filtru, volbou 
RESET COUNTER  (RESET ČÍTAČE) v dílčí nabídce BACTERIOLOGIC FILTER 
(BAKTERIOLOGICKÝ FILTR). 

 

 

Pravidelně odstraňujte případná rezidua, která se ukládají kolem těsnění (náhr. díl 
DANA038), vodou a dodanou houbičkou (neabrazivní stranou) nebo vlhkým hadříkem. 

14 ÚDRŽBA 
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Pro zachování funkční integrity přístroje je nezbytné nastavovat tlak zavírání dvířek P 
pomocí regulátoru. Pomocí páčky otočte o 60° proti směru hod. ručiček pro zvýšení 
uzavíracího tlaku; pokud chcete tlak snížit, otočte o 60° po směru hod. ručiček. 

 
 

 
 
start / konec dráhy 

 
 
 

P  
 

1 
2 

 
 

60° 
šířka oblouku 

 
páčka nastavení dvířek 

 
 
 
 
 

P  

 
1 

2 
 

 

 
 

 

 
 
 

Nastavení dvířek po 
směru hod. 
ručiček 

 
(Snížení uzavíracího tlaku) 

 
 
 
 
 

P  
 

 
1 

2 

 
 
 

 
Nastavení dvířek proti 

směru hod. ručiček 
 

(Zvýšení uzavíracího tlaku) 

Regulace dvířek Každé 2 měsíce 
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Pro širší oblouk je třeba stisknutím proti sobě uvolnit páčky, dle Obr. 2 a nastavit je na start 
rázu 1 nebo 2 (Pokud chcete otočit páčkou ke snížení uzavíracího tlaku, na start rázu 2. 
Pokud chcete otočit páčkou ke zvýšení uzavíracího tlaku, start dráhy 1) Po přemístění 
páček na start dráhy je uvolněte jako na Obr. 1 a znovu otočte příslušným směrem. 

 

 
 
 
 

Obr. 1 – Páčka zasunutá 

 

 

 

 
 

 
Obr. 2 – Páčka uvolněná 
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 14.1 Běžná údržba s technickým oprávněním  
 

 
 
 
 
 
 
 
 
 
 
 
 
 

KAŽDÉ DVA 

ROKY / 

KAŽDÝCH 

1000 CYKLŮ 

Čištění komory 

Čištění kovového filtru v komoře 

Výměna těsnění dvířek komory (DANA038) 

Mazání uzavíracího systému dvířek komory 

Nastavení uzavíracího systému dvířek komory 

Výměna bakteriologického filtru (DAVA101) 

Výměna filtru napouštění vody (DARA054) 

Čištění posměrného Y mosazného filtru k radiátoru 

Čištění ventilu solenoidu napouštění vody, případně výměna 

Čištění nádrží 

Kontrola sond hladiny nádrží 

Čištění radiátoru a chladicích větráků 

Kontrola stavu elektrického/pneumatického obvodu 

Kontrola výskytu stop dezinfekce v pneumatickém okruhu. Upozornění: 

zanedbání stop dezinfekce může znamenat nutnost 

provedení dodatečné údržby vybavení 

Kontrola bezpečnostního ventilu 

Kontrola účinnosti vakuové pumpy 

Provedení validace shody s místními normami a podle 

požadavků místních norem 

Provedení testů elektrické bezpečnosti v souladu s místními normami 

a podle požadavků místních norem 

Měření konduktivity vody ........................................................S/cm 

 

 
PO 2000 

CYKLECH 

Výměna ventilů a o-kroužků vakuové pumpy – Čištění/kontrola stavu 

membrán KNF (CPGM025 x4 – CPGM043 x2) - 

Thomas (CPGM050 x4 – CPGM051 x4 – CPGM052 x2) 

Kontrola tří N/C ventilů solenoidu 

Kontrola ohřívací části 

PO 3000 

CYKLECH 

Výměna tří N/C ventilů solenoidu (CEECG021 x3) 

Výměna ohřívací části (DXBA835 nebo DHYA035) 

Čištění/kontrola stavu membrán vakuové pumpy 
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Když se zobrazí alarmové hlášení (kód "A"), cyklus POVAŽUJTE ZA 
ZRUŠENÝ: bude nutné opakovat veškeré přípravné a sterilizační operace. 

 

 

Chybové zprávy jsou vyjádřeny pomocí alfanumerického kódu, který obsahuje písmeno a tři 
číslice. 

 

 

Alarmy a chyby resetujete současným podržením tlačítek pod lištou označenou Reset. 
 

CHYBA PŘÍČINA ŘEŠENÍ 

A 001 Cyklus přerušen uživatelem • Resetujte a restartujte 
systém. 

 
A 101 

 
Vakua nebylo dosaženo do 10 min. 

• Zkontrolujte těsnění 

• Zkontrolujte nastavení dvířek 
• Resetujte a restartujte 

systém. 

 
A 111 

Vakuum nebylo udrženo v první fázi 
VAKUOVÉHO TESTU 

• Zkontrolujte těsnění 

• Zkontrolujte nastavení dvířek 
• Resetujte a restartujte 

systém. 

 
A 121 

Vakuum nebylo udrženo ve druhé fázi 
VAKUOVÉHO TESTU 

• Zkontrolujte těsnění 

• Zkontrolujte nastavení dvířek 
• Resetujte a restartujte 

systém. 

A131 
Ve fázi předehřívání autokláv nenapustil 
správné množství vody. 

• Resetujte a restartujte systém. 

A132 Závada funkce průtokoměru • Resetujte a restartujte systém. 

A133 
Tlak je nad povoleným limitem během 
návratu vody pro zahřívací fázi. 

• Resetujte a restartujte systém. 

A 200 Chyba řízení EV operace • Resetujte a restartujte systém. 

A 400 
A 401 
A 403 
A 405 

 
Chyba uzamykání 

 
• Resetujte a restartujte systém. 

A 551 Tlak mimo limit 
• Vychlaďte místnost 

• Resetujte a restartujte systém. 

 

 
A 637 

 

 
Chyba přístupu do paměťové karty 

• Zkontrolujte, zda je SD 
karta správně vložena. 

• Zkontrolujte SD kartu: páčka 

se mohla posunout do 

“blokované” polohy. 

• Resetujte a restartujte systém. 

CHYBOVÉ ZPRÁVY 15 
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A 651 
Hodnoty ze snímače T1 během sterilizace 
jsou nad maximálním limitem 

• Vychlaďte místnost 

• Resetujte a restartujte systém. 

A 653 
Hodnoty ze snímače T2 během sterilizace 
jsou nad limitem maxima 

• Vychlaďte místnost 

• Resetujte a restartujte systém. 

A 661 Chyba odečtu snímače • Resetujte a restartujte systém. 

A 662 Chyba odečtu snímače • Resetujte a restartujte systém. 

A 701 
Chyba nedosažení tlaku během prvních 
dvou fází zahřívání 

• Resetujte a restartujte systém. 

A 711 
Chyba nedosažení tlaku během třetí fáze 
zahřívání 

• Resetujte a restartujte systém. 

A 751 
Hodnoty ze snímače T1 během sterilizace 
pod limitem minima 

• Resetujte a restartujte systém. 

A 753 
Hodnoty ze snímače T2 během sterilizace 
pod limitem minima 

• Resetujte a restartujte systém. 

A 781 
Teplota cyklu 121°C je mimo limit maxima • Vychlaďte místnost 

• Resetujte a restartujte systém. 

A 782 
Teplota cyklu 134°C je mimo limit maxima • Vychlaďte místnost 

• Resetujte a restartujte systém. 

A 801 
Chyby nedodržení maximální doby během 
první fáze vypouštění 

• Vyčistěte filtr v komoře 

• Resetujte a restartujte systém. 

A 811 
Chyby nedodržení maximální doby během 
poslední fáze vypouštění 

• Vyčistěte filtr v komoře 

• Resetujte a restartujte systém. 

 
A 901 

 
Přerušení cyklu způsobené výpadkem 
napájení 

• Zkontrolujte napájecí systém 
přístroje a v místnosti. 

• Resetujte a restartujte systém. 

 

Je zapotřebí provádět pravidelné zálohování SD karty. 

 

Pokud některý z alarmů déle přetrvává, poraďte se s technickou podporou. 
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16.1 Autokláv nesuší materiály dostatečně 

16.2 Komora autoklávu zbělala 

16.3 Komora autoklávu má modrozelené zabarvení 

16.4 Sterilizační cyklus se přerušuje bez zřejmé příčiny 

16.5 Autokláv nereaguje na ovládání 

16.6 Zbarvení nástrojů 

 

  

Ve většině případů jsou alarmy či chyby způsobeny nedostatkem pozornosti nebo 
neznalostí některých technických a provozních aspektů. Níže uvádíme seznam některých 
anomálií jejich řešení. 

 

• Vyměňte starý bakteriologický filtr za nový originální kus. 

• Byly použity neoriginální tácy, bez otvorů nebo s jinými otvory spolu s jiným materiálem. 
Doporučujeme používat pouze originální tácy. 

• Nástroje nebyly správně uspořádány. Dodržujte pokyny v kap. 10.4 
 

• Ihned vyměňte použitou vodu, používejte výhradně demineralizovanou nebo 
destilovanou vodu, jak uvádí předchozí kapitoly, a potom komoru vyčistěte. 

• Bělavé zbarvení může být následkem vypařování organických látek z nástrojů. Nástroje 
musí projít vhodnějším a důkladnějším čištěním. 

• Zkontrolujte instalovaný demineralizátor. 
 

• Nástroje nebyly řádně vyčištěny, po čištění je důkladněji oplachujte, pokud zabarvení 
nemizí, zavolejte technický servis. 

 

• Zkontrolujte, zda autokláv není připojen do sítě pomocí prodlužovačích kabelů, redukcí či 
adaptérů, a pokud ano, odstraňte tyto prvky a zapojte autokláv přímo do síťové zásuvky. 

 

• I Autokláv provádí automatické vyrovnání barometrické výšky, vyčkejte na dvojitý 
zvukový signál po otevření dvířek, potom volte funkce. 

• Nádrž na demineralizovanou vodu je prázdná, kontrolka označující minimální hladinu 
svítí, naplňte nádrž čistou vodou. 

• Nádrž na použitou vodu je plná, kontrolka označující maximální hladinu svítí, vypusťte 
použitou vodu. 

 

• Nástroje zežloutnou kvůli reziduím chemikálií, které se na ně teplem navázaly. Oplach 
nebyl vhodný. 

• Sterilizační komora je zbarvena žlutě. Některé nástroje se stopami chemických tekutin 
byly vloženy do komory a tyto tekutiny se teplem navázaly. Oplach nebyl dostatečný. 

• Nástroje mají bělavé zbarvení, oplach byl proveden příliš tvrdou vodou a nástroje nebyly 
dostatečně vysušeny. Při konečném oplachu doporučujeme používat demineralizovanou 
vodu a nástroje pečlivě oplachovat. 

• Nástroje zčernaly, protože jejich materiál obsahuje vysoké procento uhlíku. 

ŘEŠENÍ PROVOZNÍCH PROBLÉMŮ 16 
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Viz příloha Autorizovaná servisní centra 

Cod. 0Z00H0002 

 

 
 

V případě závady, potřeby kontroly nebo validace kontaktujte servisní centrum 
TECNO-GAZ S.p.A. 

 

 

Podpora posoudí vratku na ústředí nebo po zásahu technika a prohlídce přístroje, aby 
vystavila odhad nákladů, který bude postoupen distributorovi zákazníka a ten jej předá 
konečnému zákazníkovi k odsouhlasení a podpisu. 

 
Po doručení předběžného písemného souhlasu s odhadem nákladů, bude proveden servis 
autoklávu a odeslán zpět podle termínů uvedených v odhadu. 

 
Pokud musí být autokláv odeslán na opravu, kontroly, reaktivaci, revizi či validaci, je třeba 
dodržen následující závazné pokyny: 

 

1. Použijte originální obal; pokud jej již nemáte, použijte adekvátní obalový materiál. 
Náklady na dopravu hradí odesílatel. 

 

2. Autokláv posílejte samostatně (nepřikládejte žádné součásti příslušenství). 
 

3. Před odesláním řádně vyčistěte sterilizační komoru a autokláv celkově. Pokud 
přístroj přijde znečištěný nebo se zbytky reziduí, bude vrácen zpět bez provedené 
opravy, nebo projde čištěním a dezinfekcí. 

 
4. Vždy vyprazdňujte nádrž na čistou vodu pomocí nástavce na zadní části autoklávu 

(Obr.A–poz. 2 ). 
 

5. Nádrž na použitou vodu vždy vyprazdňujte pomocí nástavce na zadní části 
autoklávu (Obr.A–poz. 4 ). 

 
6. Přiložte dopis, ve kterém uvádíte přesný popis závad nebo požadovaných 

servisních prací. 
 

7. Odešlete na vlastní náklady, jinak vám bude přeprava naúčtována. 
 

Veškeré neoriginální obaly, ve kterých bude zásilka doručena, budou zlikvidovány. 
 

Váš autokláv bude navrácen v novém originálním obalu, aby byla zajištěna jeho maximální 
ochrana během přepravy. Náklady na obaly budou naúčtovány klientovi. 

17 POSTUP VYŽÁDÁNÍ SERVISU A ASISTENCE 
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DRŽÁK 
STANDARDNÍHO 
TÁCU 

 

 

TÁC 

ONYX 5.0 ONYX 8.0 ONYX 5.0 ONYX 8.0 

SXBA349 2ZXZA007
3 

DANA049 DXLA349 

 

POMŮCKA NA 
VYJMUTÍ TÁCU 

 

 

NAPÁJECÍ 
KABEL 

DANA008 CECG006 

 

 

MEZIKUS 

 

BACTERIÁLNÍ 
FILTR 

CPAP014 DAVA101 

 

FILTR KOMORY 

 

 

TĚSNĚNÍ DVÍŘEK 

DXBA091 DANA038 

 

 

HADICE PRO 
NAPOUŠTĚNÍ 

VODY 

 

 

HADICE PRO 
VYPRÁZDNĚNÍ 
POUŽITÉ VODY 

DANA099 + 
DXBA711 + 
CPRG117 

 

DANA130 

 

 

ARMATURA PRO 
VYPRÁZDNĚNÍ 
POUŽITÉ VODY 

 

 

HADICE PRO 
VYPOUŠTĚNÍ 

CPRG096 SXBA799 

 

 

HOUBIČKA 
  

CPMG004  

CHEMICKÝ INTEGRÁTOR 
200/S o 215- S 

BOWIE & DICK TEST TS001BDT 

BIOLOGICKÝ INDIKÁTOR TS002ZBK HELIX TEST TS001ZHT 

A SEZNAM SPOTŘEBNÍCH NÁHRADNÍCH DÍLŮ 



 

 

VÝBĚR 

CYKLU 

 23 24 25 14 15 16 17 

 

  

LEVEL CYCLE 
 

 

Display LCD   
 

 
 

 

SAFETY 
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I 

 

Il presente manuale deve sempre accompagnare il prodotto, in adempimento alle Direttive Comunitarie Europee. TECNO-GAZ, si riserva 
il diritto di apporre modifiche al presente documento senza dare alcun pre-avviso. La ditta TECNO-GAZ si riserva la proprietà del 
presente documento e ne vieta l’utilizzo o la divulgazione a terzi senza il proprio benestare. 

CZ 

 

Tento návod musí být stále uložen v blízkosti produktu, v souladu se směrnicemi Evropského společenství. TECNO-GAZ si vyhrazuje 
právo upravit přiložené dokumenty bez předchozího upozornění. TECNO-GAZ je výhradním vlastníkem dokumentu a nedovoluje 
ostatním jeho používání či rozšiřovánr bez vydání souhlasu. 

F 

 

Ce manuel doit toujours accompagner l'appareil conformément aux Directives de la Communauté européenne. TECNO-GAZ se réserve 
le droit d'y apporter des modifications sans aucun préavis. TECNO-GAZ se réserve la propriété de ce manuel. Toute utilisation ou 
divulgation à des tiers est interdite sans son autorisation. 

D 
Diese Anleitung muss dem Gerät in Übereinstimmung mit den Richtlinien der Europäischen Gemeinschaft beigelegt werden. TECNO- 
GAZ behält sich dar Recht vor ohne Vorankündigung Änderungen in dieser Dokumentation vorzunehmen. Die Firma TECNO-GAZ ist 
Eigentümer der vorliegenden Dokumentation und verbietet die Nutzung von Dritten oder die Weitergabe an Dritte ohne entsprechende 
Genehmigung. 

E 
El presente manual siempre deberá acompañar el producto al cual pertenece, cumpliendo las Directivas Comunitarias Europeas. 

TECNO-GAZ, reserva el derecho de aportar alteraciones al presente documento sin avisos previos. La empresa TECNO-GAZ reserva a 

si los derechos de propiedad del presente documento prohiebiendo su utilización o divulgación a terceros sin que haya expresado su 

consentimiento. 

PT 

 

O presente manual deve sempre acompanhar o produto, de acordo com as Diretivas Comunitárias Europeias. A TECNO-GAZ, reserva- 
se o direito de realizar alterações no presente documento sem qualquer aviso prévio. A empresa TECNO-GAZ reserva-se a propriedade 
do presente documento e proíbe a sua utilização ou divulgação sem o seu consentimento. 

 

http://www.tecnogaz.com/



